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1. Utilizarea Platformei educaționale TUIASI 

1.1. Autentificarea 
Platforma educațională TUIASI conține materialele didactice aferente disciplinelor studiate în cadrul 
Universității Tehnice „Gheorghe Asachi” din Iași. Aceasta este disponibilă la adresa 
https://edu.tuiasi.ro, iar accesul se face prin intermediul contului instituțional de utilizator TUIASI. 

La apăsarea butonului Autentificare prin contul TUIASI (Fig. 1) veți fi automat redirecționați pentru 
autentificare pe site-ul dedicat Managementului Identității TUIASI. După autentificare se va încărca 
pagina Home a platformei educaționale (Fig. 2). 

 

Fig. 1. Pagina de autentificare pe Platforma educațională TUIASI 

 

Fig. 2. Pagina Home a Platformei educaționale TUIASI. 

https://edu.tuiasi.ro/
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1.2. Precizări generale privind utilizarea platformei 
Toate cadrele didactice și toți studenții se pot autentifica pe platformă. 

Studenții pot accesa doar disciplinele la care au fost înrolați. 

Cadrele didactice sunt deja înrolate ca fiind Course organizer (Titular curs) sau Teaching assistant 
(Titular aplicații) și au posibilitatea să adauge alte cadre didactice sau studenți. 

Categoriile de cursuri au următoarea ierarhie: nume facultate -> ciclu studiu -> domeniu -> program 
studiu -> an studiu -> semestru. 

1.3. Precizări privind utilizarea platformei de către cadre didactice 
Cadrele didactice au posibilitatea să adauge studenți la cursurile create, fiind disponibile grupuri cu 
aceeași denumire și componență ca cele de pe Microsoft Teams și Google Meet – pe platforma 
educațională aceste grupuri poartă denumirea de cohorte (en., cohorts). 

1.4. Crearea unei discipline (opțiune indisponibilă!) 
Posibilitatea de creare a unor discipline noi a fost dezactivată deoarece disciplinele au fost create 
automat, iar cadrele didactice aferente au fost înrolate ca fiind Course organizer (Titular curs) sau 
Teaching assistant (Titular aplicații). 

Doar cadrele didactice au acces la secțiunea Administration din meniul vertical din partea stângă a 
paginii, de unde pot gestiona cursurile și categoriile de cursuri (Fig. 3). 

 

Fig. 3. Meniul de gestionare a cursurilor și a categoriilor disponibil doar cadrelor didactice. 

Pentru a crea un curs se apasă link-ul Manage courses and categories, după care se apasă pe 
butoanele plus ( ) corespunzătoare facultății, ciclului de studiu, domeniului, programului de studio 
și anului de studiu în care este disciplina care se dorește a se crea. Apoi se apasă pe semestrul dorit și 
în partea dreaptă va apărea numele semestrului și butonul Create a new course (Fig. 4). 

La apăsarea butonului se deschide pagina care permite crearea unui curs nou în categoria selectată 
(Fig. 5). Multe din câmpurile prezentate ar trebui să rămână cu valoarea lor implicită, iar o prezentare 

scurtă a ce reprezintă fiecare câmp se poate vedea prin apăsarea butonului . 

Configurarea implicită a cursului presupune existența a trei secțiuni în care cadrul didactic își poate 
adăuga cursuri, lucrări de seminar/laborator și alte activități. Dacă se dorește schimbarea într-un alt 
format (e.g., Weekly format – materialele pentru curs/seminar/laborator să fie organizate pe 
săptămâni) acest lucru se poate face de la secțiunea Course format -> Format: Weekly format 
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Câmpurile care ar trebui modificate sunt următoarele (celelalte câmpuri ar trebui să rămână pe 
valoarea lor implicită): 

Secțiunea General 

1. Course full name – numele complet al cursului (e.g., Programare web), 
2. Course short name – numele prescurtat al cursului (e.g., AC_CTI3_PW, unde AC este 

acronimul facultății, CTI este programul de studiu, 3 este anul de studiu și PW este acronimul 
cursului), 

Secțiunea Description 

1. Course summary – scurtă descriere a cursului 

 

Fig. 4. Exemplu de selectare a categoriei în care se dorește a crea cursul. În acest exemplu se dorește crearea 
unui curs la AC, domeniul și programul de studii Calculatoare și tehnologia informației, anul 3, semestrul II. 
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Fig. 5. Exemplu de completare a secțiunii General în momentul creării unui curs. 

Toate celelalte câmpuri ar trebui să rămână pe valorile lor implicite. Pentru a crea efectiv cursul se 
apasă butonul Save and display. 
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1.5. Configurarea disciplinei 
Disciplinele la care este înrolat un utilizator pot fi vizualizate 
din secțiunea My courses a panoului Navigation din partea 
stângă a paginii (Fig. 6). 

Odată selectată o anumită disciplină, este disponibil meniul 
Course administration pentru administrarea disciplinei 
selectate (Fig. 8) în panoul de administrare Administration 
(în partea stângă a paginii, sub panoul Navigation).  

În cele ce urmează sunt prezentați pașii necesari configurării 
inițiale a disciplinei create. 

1.5.1. Adăugarea cadrelor didactice la disciplină 
Dacă se dorește adăugarea unor persoane cu rol de editare a 
conținutului disciplinei trebuie să le înrolați ca Course 
organizer (Titular curs) sau Teaching assistant (Titular 
aplicații) la disciplină. 

Extindeți sub-meniul Users (Fig. 7) din meniul Course 
administration (Fig. 8) și selectați Enrolled users. În partea 
principală a paginii apar participanții la curs. Din partea 
dreaptă apăsați butonul Enrol users. 

Apare fereastra de Enrol Users cu Enrolment options (Fig. 9). 

Pentru a adăuga cadrul didactic, numele acestuia trebuie 
căutat în căsuța Select users, iar la Assign role se selectează 
Teacher. După selectarea persoanelor dorite se apasă 
butonul Enrol selected users and cohorts. 

1.5.2. Adăugarea studenților la disciplină 
Pentru a se păstra o sincronizare între grupurile de studenți 
de Microsoft Teams și Google Meet, și grupurile (cohortele) 
de pe platforma educațională TUIASI, adăugarea studenților 
trebuie să se facă printr-o sincronizare cu grupurile 
corespunzătoare după cum urmează. 

Din panoul Administration (Fig. 8) -> Course Administration -> Users (Fig. 7) selectați Enrolment 
methods, apoi de la Add method selectați Cohort sync (Fig. 10). 

Puneți ce nume doriți la Custom instance name, iar de la Cohort selectați grupul de studenți dorit 
(sunt aceleași grupuri ca pe Microsoft Teams / Google Meet). 

Dacă se dorește o organizare pe grupe ar trebui selectată cohorta care reprezintă grupa (e.g., 
ac_licenta_1309A), iar de la Add to group trebuie selectat Create new group. Se recomandă ca pentru 
Custom instance name să se utilizeze numele grupei. 

Pentru a adăuga efectiv studenții se apasă butonul Add method. 

Dacă se dorește adăugarea altor cohorte se repetă procesul. 

Fig. 6. Meniul de navigare. 

Fig. 7. Sub-meniul de gestionare a 
utilizatorilor înrolați la curs (accesibil din 
secțiunea Course administration a 
panoului Administration). 
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Fig. 8. Meniul de administrare a unei discipline cu marcarea opțiunilor celor mai importante. 

 

Fig. 9. Fereastra de înrolare a cadrelor didactice la disciplină. 

Modificarea setărilor făcute la crearea cursului 

Adăugarea de fișiere și activități în cadrul topic-urilor 

Înrolarea (adăugarea) studenților la disciplină 

Vizualizarea rapoartelor de activitate a participanților 

Gestionarea întrebărilor de la teste (banca de întrebări) 

Încărcarea unei discipline exportată dintr-o altă instanță de Moodle 

Realizarea unei copii de siguranță a cursului 
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Fig. 10. Adăugarea cohortelor de studenți la o disciplină 

1.5.3. Redenumirea secțiunilor 
În vederea redenumirii secțiunilor, trebuie să fie activat modul de editare (vezi secțiunea 1.4.1. 
Modificarea conținutului unei discipline). 

Dacă la crearea disciplinei ați formatul cursului ca fiind Topics format (aceasta este varianta 
implicită), atunci disciplina are patru secțiuni: Announcements (Anunțuri), Topic 1, Topic 2 și Topic 3. 

Pentru a redenumi o secțiune, se apasă pe butonul de editare  a secțiunii respective și se 
introduce textul dorit. Un exemplu de denumire a secțiunilor este prezentat în Fig. 11. 

 

Fig. 11. Pagina care conține conținutul unei discipline cu modul de editare activat. Exemplu de denumire a 
secțiunilor din cadrul unei discipline 
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1.5.4. Încărcarea unei discipline exportată dintr-o altă instanță de Moodle 
1.5.4.1. Salvarea disciplinei de pe platforma Moodle veche 
Din zona de administrare a cursului (meniul Course Administration din partea dreaptă a cursului) se 
selectează opțiunea Backup (Fig. 8). 

Sunt 5 pași care trebuie parcurși pentru a realiza copia de siguranță: 

1. Initial settings. Este important ca să nu se salveze utilizatorii înrolați și grupurile. Adică, ar trebui 
debifate opțiunile Include enrolled users și Include groups and groupings. 

De obicei, opțiunile selectate sunt: Include activities and resources, Include blocks, Include files și 
Include question bank. 

2. Schema settings. Aici se pot selecta activitățile care să fie incluse. Ar putea să fie lăsate toate 
selectate. 

3. Confirmation and review. Aici se poate specifica un anumit nume de fișier pentru copia de siguranță 
și este prezentată o listă cu informațiile salvate. Se poate trece mai departe apăsând butonul Perform 
backup. 

4. Perform backup. În acest pas se salvează cursul, după care se apasă butonul Continue. 

5. Complete. 

În acest moment, este încărcată automat secțiunea Restore din panoul Course administration. În 
partea de jos a paginii este disponibilă zona User private backup area, de unde se poate descărca 
copia de siguranță realizată prin apăsarea butonului Download (Fig. 12). 

 

Fig. 12. Zona User private backup area a paginii Restore din meniul Course adminsitration 

1.5.4.2. Încărcarea disciplinei salvate pe platforma educațională TUIASI 
Se accesează cursul care se dorește a fi populat cu informația din cursul de pe platforma Moodle 
veche. 

Din zona de administrare a cursului (meniul Course Administration din partea dreaptă a cursului) se 
selectează opțiunea Restore (Fig. 8). 

În zona Import a backup file se încarcă copia de siguranță realizată la pasul anterior (se poate folosi 
metoda drag-and-drop pentru a încărca mai ușor fișierul). După ce se termină de încărcat fișierul se 
apasă butonul Restore. 

Sunt 7 pași care trebuie parcurși: 

1. Confirm. Aici doar trebuie de apăsat butonul Continue din josul paginii. 
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2. Destination. Deoarece a fost aleasă opțiunea Restore din cadrul cursului care se dorește a fi 
populat, de pe această pagină trebuie apăsat butonul Continue din prima zonă (Restore into this 
course). 

3. Settings. Aici este important ca la Include enrolment methods să rămână selectată opțiunea No, 
apoi se apasă butonul Continue. 

4. Schema. La Overwrite course configuration trebuie să rămână selectat No, apoi se poate apăsa 
butonul Next din josul paginii. 

5. Review. Aici este prezentată lista cu informațiile care vor fi incluse în curs. În josul paginii trebuie 
apăsat butonul Perform restore. 

6. Process. În acest pas se încarcă informațiile din vechiul curs, după care se trece la următorul pas. 

7. Complete. S-a terminat procesarea și se poate apăsa butonul Continue. 

1.6. Gestionarea disciplinei 
1.6.1. Modificarea conținutului unei discipline 
Când se dorește modificarea conținutului unei discipline, trebuie, în primul rând, ca să fie activat 
modul de editare. 

Acest lucru se realizează din panoul Course administration al disciplinei (Fig. 8), prin apăsarea pe Turn 
editing on. (Atenție! La ultima versiune de Moodle, această opțiune nu mai este disponibilă și trebuie 
utilizată alternativa următoare). 

Aceeași opțiune este disponibilă în partea dreaptă a meniului orizontal principal de sub antetul paginii 
web (Fig. 12). 

 

Fig. 13. Meniul orizontal principal al platformei educaționale 

1.6.2. Adăugarea activităților și a resurselor 
Pentru a adăuga diverse fișiere, cea mai simplă variantă este prin drag-and-drop, adică de a selecta 
fișierele de pe calculator și de a le trage în secțiunea dorită a disciplinei de pe platforma Moodle. 

O altă variantă este legătura cu numele Add an activity or resource din partea dreaptă-jos a fiecărei 
secțiuni (Fig. 11). Activitățile și resursele care pot fi adăugate cu această opțiune sunt prezentate în 
Tabelul 1 (activitățile cele mai utilizate sunt marcate îngroșat). 

Tabelul 1. Variantele de activități și resurse care pot fi adăugate într-o secțiune (activitățile cele mai utilizate sunt 
marcate îngroșat). 

ACTIVITIES ACTIVITĂȚI 

 
Assignment Colectarea unor teme 

 
Attendance Efectuarea prezenței 

 
Chat Discuții în timp real 
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Choice Sondaj de opinie cu o singură întrebare și mai multe variante 

de răspuns 

 
Database Tabel cu diverse informații 

 
Dataform Modul complex pentru crearea de activități și resurse 

 
External tool Conectarea la soluții externe 

 
Feedback Sondaj de opinie / Colectare de feedback 

 
Forum Forum – similar cu secțiunea Announcements (Anunțuri) 

 
Glossary Glosar 

 
Lesson Lecție – înșiruire de pagini cu navigare în funcție de 

răspunsurile studentului 

 
Questionnaire 

Similar cu Feedback, dar cu posibilitatea de a nota studentul 
și de a avea întrebări care apar în funcție de răspunsul dat la 
alte întrebări  

 
Quiz Teste de mai multe feluri (eseu și întrebări cu răspuns unic, 

multiplu, de completat, de asociere, ...) 

 
SCORM package Soluție externă - https://scorm.com/scorm-explained/ 

 
Survey Alegerea între câteva sondaje de opinie existente de evaluare 

a procesului de învățare 

 
Wiki Crearea și editarea unei colecții de pagini web (poate fi 

colaborativă) 

 
Workshop Colectarea, recenzia și evaluarea între studenți (peer 

assessment) a unei activități 

RESOURCES RESURSE 

 
Book Resursă cu mai multe pagini într-un format similar cu al unei 

cărți 

 
File Adăugarea unui fișier 

 
Folder Adăugarea unui director care poate să conțină mai multe 

fișiere 

 
IMS content 
package 

Soluție externă - 
http://www.imsglobal.org/content/packaging/index.html 

 
Label Adăugarea unui text sau conținut multimedia în interiorul 

unei secțiuni 

 
Page Crearea unei pagini web 

 
URL Adăugarea unei legături spre o resursă externă 

 

https://scorm.com/scorm-explained/
http://www.imsglobal.org/content/packaging/index.html
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1.6.3. Comunicarea cu studenții 
Comunicarea cu studenții se poate realiza trimițând mail de pe adresa instituțională la grupurile de 
studenți corespunzătoare, sau se poate realiza prin intermediul platformei Moodle. 

În prima secțiune a disciplinei există forumul Announcements, unde se pot adăuga mesaje cu ajutorul 
butonului Add a new topic. Topic-ul reprezintă o discuție pe o anumită temă, dar nu este neapărat ca 
să existe răspunsuri din partea studenților. 

Această variantă cu Announcements -> Add a new topic poate fi folosită pentru a se afișa un anumit 
mesaj, iar acel mesaj este și trimis pe mail tuturor studenților înrolați la disciplină. 
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2. Sugestii de examinare online 

2.1. Recomandări 
Se recomandă ca testul să fie susținut în același timp de toți studenții, iar durata de rezolvare să fie 
suficient de scurtă, astfel încât să se minimizeze timpul disponibil pentru comunicarea între studenți 
și posibilitatea de fraudare a examinării. 

Pentru un examen care are în mod normal mai multe părți, se poate crea câte un test pentru fiecare 
parte. De exemplu, un test de teorie de durată scurtă pentru a elimina timpul necesar 
copierii/comunicării între studenți, apoi unul practic la care ar avea voie cu orice material și care 
durează mai mult. 

Circulația rezolvărilor între studenți nu poate fi complet evitată, indiferent de soluția aleasă. Studenții 
pot realiza fotografii cu telefonul ale subiectelor/rezolvărilor și le pot distribui colegilor. O abordare 
posibilă este de a finaliza evaluarea cu o sesiune orală adițională testului, prin Google Meet / Microsoft 
Teams, în care studenții primesc, pe rând, întrebări referitoare la rezolvările trimise. 

2.2. Variante de examinare 
A. Test cu mai multe întrebări și răspunsuri rapide (răspuns unic, multiplu, de completat, …) - durată 
de timp impusă 

− Corectare automată 
− Corectare manuală 
− Corectare mixtă (la unele întrebări automată, iar la altele manuală) 

B. Rezolvarea unor probleme cu încărcarea ulterioară a soluției - durată de timp impusă 
− Timp scurt pentru limitarea posibilității de a utiliza surse de informare 
− Timp mai lung (de ordinul zilelor), dacă au voie să folosească surse de informare 

2.3. Precizări importante referitoare la desfășurarea testului 
Implicit, în timpul testului, se salvează o dată la un minut toate răspunsurile bifate de către student. 

Dacă se întrerupe conexiunea la Internet sau studentul se mută la un alt calculator, studentul poate 
continua testul de unde a rămas. 

Întrebările ar trebui să nu fie aceleași pentru toți. Platforma Moodle oferă posibilitatea ca variantele 
de răspuns să fie amestecate, întrebările să fie amestecate, și lista de întrebări primite de către un 
student să fie un subset (sau mai multe subseturi - categorii) dintr-un set mai mare definit în banca de 
întrebări (en., Question bank). 

Dacă se dorește scrierea unor formule matematice, platforma Moodle suportă LaTeX. 

De asemenea, este realizată integrarea cu MatLab și cu Google Assignments. 
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3. Test cu mai multe întrebări - Quiz 

3.1. Banca de întrebări - Question bank 
3.1.1. Configurarea băncii de întrebări 
Materia pentru test poate să fie împărțită în cât mai multe subcapitole, iar pentru fiecare subcapitol 
să existe mai multe întrebări. Pentru testul propriu-zis se poate configura alegerea aleatorie (random 
question) a unui număr specificat de întrebări din fiecare subcapitol, astfel încât testele să fie diferite 
pentru fiecare student, iar studenții să fie evaluați pentru toată materia. 

Toate întrebările care pot să apară în diverse teste de la o anumită disciplină pot fi organizate cu 
ajutorul băncii de întrebări (Question bank). 

Banca de întrebări se poate accesa din meniul de administrare a cursului (Course Administration) din 
partea stângă a paginii web a disciplinei (Fig. 13) 

Întrebările pot fi organizate pe categorii și subcategorii (Fig. 14) din tab-ul Categories a paginii 
Question bank. 

Adăugarea întrebărilor se realizează din tab-ul Question prin apăsarea butonului Create a new 
question... (Fig. 15). 

Fig. 14. Accesarea băncii de 
întrebări. 

Fig. 15. Exemplu de categorii de întrebări. În paranteză pare numărul 
de întrebări din fiecare categorie. 
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Fig. 16. Secțiunea de gestionare a întrebărilor dintr-o categorie. Exemplu de întrebări create. 

 

Există mai multe tipuri de întrebări, acestea fiind prezentare în secțiunea următoare. 

Fiecare întrebare poate a avea mai multe tag-uri cu ajutorul cărora se vor putea adăuga întrebări în 
momentul în care se configurează Quiz-ul. Aceasta este o alternativă la utilizarea categoriilor pentru 
a adăuga mai multe întrebări la un Quiz. 

3.1.2. Tipuri de întrebări 
Există mai multe tipuri de întrebări care pot fi folosite pentru testarea studenților. Documentația 
pentru fiecare tip de întrebare se găsește la adresa https://docs.moodle.org/38/en/Questions. 

Cele mai utilizate tipuri de întrebări sunt Multiple choice (întrebare cu răspuns unic/multiplu) și Essay 
(întrebare la care răspunsul este un text, dar pot fi încărcate și fișiere). 

În cele ce urmează sunt prezentate tipurile de întrebări disponibile pe platforma educațională TUIASI. 

1. Multiple choice - Moodle atenționează dacă este unul sau sunt mai multe răspunsuri corecte 

https://docs.moodle.org/38/en/Questions
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a. One answer only - se poate ca un singur răspuns să fie corect sau ca oricare din mai 
multe răspunsuri să fie corecte 

b. Multiple answers allowed - întrebare cu răspunsuri multiple; se calculează punctaje 
parțiale; la variantele greșite se poate stabili pentru Grade un procentaj negativ 
pentru ca răspunsurile bifate greșit să ducă la o penalizare în calcularea procentajului 
pentru scorul întrebării 

2. True/False - întrebare la care răspunsurile posibile sunt adevărat sau fals 
3. Matching - există o listă de întrebări și o listă de răspunsuri pe care studentul trebuie să le 

potrivească 
4. Short answer - se specifică cel puțin un răspuns care să fie considerat corect; se poate folosi 

wildcard (*); dacă răspunsul studentului nu coincide EXACT ar putea fi înregistrat ca răspuns 
greșit (prin “exact” înțelegem inclusiv la numărul de spații / litere mari/mici); o variantă ar fi 
ca răspunsul să fie format dintr-un număr sau un singur cuvânt pentru a nu apărea obiecții; o 
altă variantă constă în specificarea mai multor răspunsuri (variațiuni ale formulării 
răspunsului) acceptate ca fiind corecte 

5. Numerical - răspunsul este o valoare numerică și se poate specifica o toleranță și unitate de 
măsură 

6. Essay - răspunsul este un text sau se poate încărca un fișier; corectarea nu este automată 
7. All-or-Nothing Multiple Choice* - similar cu Multiple answers allowed, dar se primește 

punctajul doar dacă s-au bifat toate răspunsurile corecte (nu există punctaje parțiale) 
8. Calculated - întrebări cu răspuns numeric care au variabile în textul întrebării și răspunsul este 

calculat pe baza unei formule https://docs.moodle.org/38/en/Calculated_question_type 
9. Calculated multichoice - variantă similară cu Calculated, dar cu răspunsuri multiple - 

https://docs.moodle.org/38/en/Calculated_multichoice_question_type 
10. Calculated simple - variantă simplificată a Calculated - 

https://docs.moodle.org/38/en/Simple_calculated_question_type 
11. Drag and drop into text - se dă un text care are cuvinte lipsă, iar studentul trebuie să tragă 

cuvinte dintr-o listă în locurile goale din text 
12. Drag and drop markers - se dă o imagine, iar studentul trebuie să tragă marker-i (e.g., text, 

imagini) pe imaginea respectivă; trebuie definite zonele unde pot ajunge marker-ii prin 
specificare coodonatelor unor cercuri, dreptunghiuri sau poligoane) - 
https://docs.moodle.org/38/en/Drag_and_drop_markers_question_type 

13. Drag and drop onto image - diferența față de Drag and drop markers este că zonele de pe 
imagine unde pot ajunge marker-ii sunt vizibile studenților 

14. Embedded answers (Cloze) - se dă un text care conține mai multe tipuri de răspuns (multiple 
choice, short answer, numerical); această variantă oferă o flexibilitate mare în crearea unei 
întrebări complexe - 
https://docs.moodle.org/38/en/Embedded_Answers_(Cloze)_question_type 

15. Ordering* - studentul trebuie să pună în ordine o listă de itemi 
16. Pattern match* - variantă similară cu Short answer, dar răspunsul dat de student este 

comparat cu un pattern cu sintaxă specifică - https://docs.moodle.org/38/en/Pattern-
match_question_type_detailed_documentation 

17. Random short-answer matching - variantă similară cu Matching, doar că întrebările și 
răspunsurile sunt alese aleatoriu dintre întrebările de tipul Short answer din categoria curentă 
(în care se află întrebarea Random short-answer matching) 

https://docs.moodle.org/38/en/Calculated_question_type
https://docs.moodle.org/38/en/Calculated_multichoice_question_type
https://docs.moodle.org/38/en/Simple_calculated_question_type
https://docs.moodle.org/38/en/Drag_and_drop_markers_question_type
https://docs.moodle.org/38/en/Embedded_Answers_(Cloze)_question_type
https://docs.moodle.org/38/en/Pattern-match_question_type_detailed_documentation
https://docs.moodle.org/38/en/Pattern-match_question_type_detailed_documentation
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18. Regular expression short answer* - variantă similară cu Short answer, dar răspunsul dat de 
student este comparat cu o expresie regulată (atenție, există limitări importante! următoarele 
caractere nu pot fi folosite decât pentru valoarea lor literară: . ^ $ * + { } \ /) - 
https://docs.moodle.org/38/en/Regular_Expression_Short-Answer_question_type 

19. Select missing words - variantă similară cu Drag and drop into text, doar că nu se trage textul, 
ci se folosesc drop-down-uri 

20. Description -  este doar un text afișat studentului (nu este un tip de întrebare) 
* acest tip de întrebări nu sunt disponibile în instalarea standard de Moodle, dar pot fi utilizate pe platforma 
Moodle TUIASI 

3.1.3. Utilizarea Microsoft Word pentru gestionarea întrebărilor 
În pagina Question bank există posibilitatea de a salva întrebările create în format Word (tab-ul 
Export) și de a adăuga întrebări dintr-un document Word (tab-ul Import). 

Formatul de fișier care trebuie ales la import/export este Microsoft Word 2010 table format 
(wordtable). Un exemplu de întrebare dintr-un fișier Word este prezentat în Fig. 16. 

 

Fig. 17. Exemplu de întrebare din Microsoft Word care poate fi importată pe platforma Moodle 

Tutorialul pentru instalarea template-ului care facilitează redactarea întrebărilor în Word este 
disponibil la adresa: http://www.moodle2word.net/mod/hvp/view.php?id=130. 

Ca alternativă, se pot crea câteva întrebări direct în banca de întrebări de pe platforma Moodle, apoi 
acestea se pot exporta în Word. Astfel, documentul va conține exemple de întrebări care se pot replica 
și modifica. După ce se editează documentul prin adăugarea de întrebări noi, se poate importa 
documentul pe platforma educațională. Această abordare are dezavantajul că nu se face o verificare 
automată a corectitudinii formatării întrebărilor, precum se face în variata utilizării template-ului. 

https://docs.moodle.org/38/en/Regular_Expression_Short-Answer_question_type
http://www.moodle2word.net/mod/hvp/view.php?id=130
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3.2. Crearea testului propriu-zis 
3.2.1. Configurare test 
În vederea creării unui test (Quiz), trebuie să fie activat modul de editare (vezi secțiunea 1.4.1. 
Modificarea conținutului unei discipline). 

Din secțiunea în care doriți să apară textul, alegeți opțiunea Add an activity or resource -> Quiz. 

3.2.1.1. General (numele și descrierea) 
În această secțiune se completează numele și descrierea testului. Se poate bifa dacă se dorește ca 
descrierea să fie afișată pe pagina disciplinei, sau doar în momentul în care studentul accesează testul. 

3.2.1.2. Timing (durata testului) 
Exemplu de test care durează 60 de minute: Studenții pot da start la test începând cu ora 10:00, dar, 
indiferent de ora la care dau start, testul se încheie la 11:03. Deci studenții au 3 minute în care să dea 
start la test fără a pierde din timpul de 60 minute alocat testului. La expirarea timpului, se dă Submit 
automat la test pentru cei care nu au dat deja Submit. 

 

Fig. 18. Secțiunea Timing de la configurarea unui Quiz 

3.2.1.3. Grade (notarea) 
Dacă este configurat catalogul de pe Moodle (Gradebook) se poate specifica ce categorie din catalog 
se completează cu notele de la test. 

 

Fig. 19. Secțiunea Grade de la configurarea unui Quiz 

3.2.1.4. Layout (modul de afișare a întrebărilor) 
Se poate specifica numărul de întrebări pe pagină (e.g., toate, o întrebare pe pagină) și dacă studentul 
trebuie să răspundă la întrebări în ordine sau se poate întoarce oricând la o întrebare precedentă sau 
poate sări întrebări. 
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Fig. 20. Secțiunea Layout de la configurarea unui Quiz 

3.2.1.5. Question behaviour (setări în cadrul unei întrebări) 
Se specifică dacă variantele de răspuns din cadrul întrebărilor să fie amestecate. La ”How questions 
behave” lăsați ”Deferred feedback” ca testarea să fie similară cu o testare fizică (offline). 

 

Fig. 21. Secțiunea Question behaviour de la configurarea unui Quiz 

3.2.1.6. Review options (informațiile referitoare la test vizualizare de către student) 
Specifică ce informații referitoare la test poate să vadă studentul în timpul testului, imediat după ce a 
terminat testul, cât timp testul nu s-a terminat pentru toată lumea, și după terminarea testului pentru 
toată lumea.  

Atenție! Opțiunile dezactivate (disabled - cu checkbox gri) nu sunt active, chiar dacă apar bifate. 

 

Fig. 22. Secțiunea Review options de la configurarea unui Quiz 
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3.2.1.7. Appearance (opțiuni de afișare) 
Opțiunile de aici pot să rămână pe valorile implicite. 

 

Fig. 23. Secțiunea Apperance de la configurarea unui Quiz 

3.2.1.8. Extra restrictions on attempts (restricții suplimentare la testare) 
Aici se poate specifica o parolă care trebuie introdusă de studenți ca să poată susține testul. 

Neapărat trebuie setată opțiunea de la ”Browser security”. 

Atenție! Dacă se setează opțiunea ”Browser security”, studenții nu vor putea da copy-paste. 

 

Fig. 24. Secțiunea Extra restrictions on attempts de la configurarea unui Quiz 

3.2.1.9. Overall feedback (feedback-ul obținut la terminarea testului)) 
Permite specificarea afișării unui text, după ce studentul a terminat testul, în funcție de nota obținută. 
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Fig. 25. Secțiunea Overall feedback de la configurarea unui Quiz 

3.2.1.10. Common module settings (Setări generice module) 
Se poate seta ca testul să fie ascuns studenților până la finalizarea configurărilor și adăugării 
întrebărilor. Dacă testul este individual, câmpul ”Group mode” trebuie neapărat setat pe valoarea ”No 
groups”. 

 

Fig. 26. Secțiunea Common module settings de la configurarea unui Quiz 

3.2.1.11. Restrict access (Restricționare acces) 
Se poate seta ca să poată accesa testul doar studenții dintr-o anumită grupă sau serie. Implicit, dacă 
nu se adaugă nicio restricție, pot da testul toți studenții înrolați la disciplină. 

După apăsarea butonului Add restriction... se selectează opțiunea Cohort. De aici se selectează grupul 
(cohorta) care ar trebui să poată participa la test. 

Dacă se dorește ca studenții care nu sunt din grupurile respective nici măcar să nu vadă testul pe 
pagina disciplinei, trebui apăsată iconița din dreptul grupului ( ) ca să devină . 



Serviciul Sisteme de Comunicații Digitale 25 

 

Fig. 27. Secțiunea Restrict access de la configurarea unui Quiz 

3.2.1.12. Activity completion / Tags / Competencies (Finalizare activitate / Etichete / 
Competențe) 

Aici se pot lăsa valorile deja setate. Platforma Moodle nu a fost configurată pentru a lucra cu marcarea 
unei activități ca fiind completă sau cu competențe. 

3.2.2. Adăugarea întrebărilor 
După ce testul a fost configurat și s-a apăsat butonul Save and return to course se dă click pe testul 
creat și, din meniul din dreapta cu numele Quiz administration, se dă click pe Edit quiz. 

Aici se poate specifica nota maximă și se pot adăuga întrebări. 

Dacă se dorește ca întrebările să fie într-o ordine aleatorie, trebuie bifată opțiunea Shuffle. 

Moodle nu suportă notă/punct din oficiu, iar dacă se dorește totuși acest lucru, se poate pune o 
întrebare de tipul Short answer sau Multiple choice la care orice răspuns dat să fie corect. Atenție, 
dacă studentul nu bifează nimic, atunci nu primește punctajul. 

Alternativa este ca la punctajul calculat automat după susținerea testului pe Moodle, să se adauge 
manual punctul din oficiu în calculul notei la proba corespunzătoare. 

 

Fig. 28. Exemplu de test cu întrebări adăugate 
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Întrebările se pot adăuga din meniul Add din dreapta jos. 

 

Fig. 29. Meniul de adăugare a unei întrebări la test 

Este bine ca întrebările să fie definite pe categorii în Question bank-ul disciplinei. 

Exemplu: dacă o categorie are 50 de întrebări, se poate folosi opțiunea Add -> a random question 
pentru a adăuga la test 30 de întrebări aleatorii din categoria de 50 de întrebări. Acest lucru înseamnă 
că fiecare student va primi la test 30 de întrebări aleatorii dintr-un set de 50 de întrebări. 

În mod similar, se pot adăuga subseturi întrebări din diferite categorii existente în banca de întrebări. 

3.2.3. Vizualizarea răspunsurilor date de către studenți 
Accesarea răspunsurilor date de către studenți se realizează accesând activitatea creată de tipul Quiz 
care este afișată pe pagina disciplinei (Fig. 29), după care se apasă pe legătura Attempts. 

 

Fig. 30. Exemplu de activitate de tipul Quiz afișată pe pagina disciplinei 

În panoul Quiz administration din partea stângă a paginii se găsesc opțiunile de gestionare a testului. 
De exemplu, se poate modifica configurarea testului (Edit settings), se pot gestiona întrebările (Edit 
quiz), se poate pre-vizualiza testul (Preview), se pot vedea notele obținute (Results -> Grades) sau se 
pot vedea răspunsurile date de către studenți (Results -> Responses). 

  

Crearea și adăugarea unei întrebări noi 

Adăugarea unei anumite întrebări existente din banca 
de întrebări 

Specificarea unui anumit număr de întrebări existente 
dintr-o anumită categorie din banca de întrebări 
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4. Rezolvarea unor probleme cu încărcarea ulterioară a soluției 
- Assignment 

4.1.1. Configurare assignment (sarcină de lucru / lucrare) 
În vederea creării unei sarcini de lucru (Assignment), trebuie să fie activat modul de editare (vezi 
secțiunea 1.4.1. Modificarea conținutului unei discipline). 

Din secțiunea în care doriți să apară textul, alegeți opțiunea Add an activity or resource -> Assignment. 

4.1.1.1. General (numele și descrierea) 
În această secțiune se completează numele și descrierea assignment-ului. Se poate bifa dacă se 
dorește ca descrierea să fie afișată pe pagina disciplinei, sau doar în momentul în care studentul 
accesează assignment-ul. 

Tot aici se pot încărca diverse fișiere la care are acces studentul. 

4.1.1.2. Availability (Disponibilitatea) 
În exemplul din Fig. 30 se permite studenților să trimită rezolvările începând cu data de 7 iunie (Allow 
submissions from) și până la data de 17 iunie (Cut-off date), dar rezolvările trimise după data de 14 
iunie (Due date) vor fi marcate ca fiind întârziate. Cadrul didactic este notificat ca să corecteze 
rezolvările până la data de 21 iunie (Remind me to grade by).  

 

Fig. 31. Secțiunea Availability de la configurarea unui Assignment 

4.1.1.3. Submission types (Tipuri de răspuns) 
Studenții pot încărca rezolvările prin introducerea unui text (rich text – care poate conține text 
îngroșat și înclinat, imagini, legături și alte elemente) și/sau prin încărcarea unor fișiere (imagini, pdf). 

Se poate specifica o limită pentru numărul maxim de cuvinte din text, sau pentru numărul maxim de 
fișiere, dimensiunea maximă și tipul fișierelor acceptate. 
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Fig. 32. Secțiunea Submission types de la configurarea unui Assignment 

4.1.1.4. Feedback types (Tipuri de feedback) 
Evaluatorul rezolvărilor va putea lăsa câte un comentariu fiecărui student (Feedback comments), 
descărca și apoi încărca un document cu notele (Offline grading worksheet) și/sau să încarce fișiere 
de feedback (Feedback files). 

 

Fig. 33. Secțiunea Feedback types de la configurarea unui Assignment 

4.1.1.5. Submission settings (Setările răspunsurilor) 
În această secțiune sunt câteva opțiuni referitoare la trimiterea rezolvărilor. Cea mai importantă fiind 
setarea care specifică dacă se permite ca studenții să re-trimită rezolvări (Attemps reopened). 

 

Fig. 34. Secțiunea Submission settings de la configurarea unui Assignment 

4.1.1.6. Group submission settings (Setările răspunsurilor trimise în grup) 
Se poate seta ca studenții fie organizați în grupuri, iar rezolvările să fie trimise ca fiind din partea 
întregului grup și nu din partea unui anumit student. 
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Fig. 35. Secțiunea Group submission settings de la configurarea unui Assignment 

4.1.1.7. Notifications (Notificări) 
Se poate seta ca persoanele care fac notarea (cadrele didactice) să fie notificați prin email de 
trimiterea unei rezolvări de către un student. 

 

Fig. 36. Secțiunea Notifications de la configurarea unui Assignment 

4.1.1.8. Grade (Notă) 
Se specifică setările pentru modalitatea de notare a rezolvărilor. Acest lucru este important dacă se 
utilizează componenta Gradebook (catalog). 

 

 

Fig. 37. Secțiunea Grades de la configurarea unui Assignment 
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4.1.1.9. Common module settings (Setări generice module) 
Se poate seta ca testul să fie ascuns studenților până la finalizarea configurărilor și adăugării 
întrebărilor. Dacă testul este individual, câmpul ”Group mode” trebuie neapărat setat pe valoarea ”No 
groups”. 

 

Fig. 38. Secțiunea Common module settings de la configurarea unui Assignment 

4.1.1.10. Restrict access (Restricționare acces) 
Se poate seta ca să poată accesa testul doar studenții dintr-o anumită grupă sau serie. Implicit, dacă 
nu se adaugă nicio restricție, pot da testul toți studenții înrolați la disciplină. 

După apăsarea butonului Add restriction... se selectează opțiunea Cohort. De aici se selectează grupul 
(cohorta) care ar trebui să poată participa la test. 

Dacă se dorește ca studenții care nu sunt din grupurile respective nici măcar să nu vadă testul pe 
pagina disciplinei, trebui apăsată iconița din dreptul grupului ( ) ca să devină . 

 

Fig. 39. Secțiunea Restrict access de la configurarea unui Assignment 

4.1.1.11. Activity completion / Tags / Competencies (Finalizare activitate / Etichete / 
Competențe) 

Aici se pot lăsa valorile deja setate. Platforma Moodle nu a fost configurată pentru a lucra cu marcarea 
unei activități ca fiind completă sau cu competențe. 

4.1.2. Vizualizarea rezolvărilor trimise de către studenți 
Accesarea rezolvărilor trimise de către studenți se realizează accesând activitatea creată de tipul 
Assignment care este afișată pe pagina disciplinei (Fig. 39). 
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Fig. 40. Exemplu de activitate de tipul Assignment afișată pe pagina disciplinei 

Butonul View all submissions permite vizulizarea și descărcarea rezolvărilor trimise, iar butonul Grade 
permite notarea studenților la activitatea respectivă. 
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5. Alternative pentru testarea prin rezolvarea unor probleme 
cu încărcarea ulterioară a soluției 

5.1. Descrierea scenariului 

1. Studentul descarcă un document PDF cu textul problemelor de rezolvat sau îi apare direct pe 
Moodle textul problemelor 

2. Studentul rezolvă pe hârtie problemele sau într-un document electronic 
3. Studentul pozează și încarcă imaginile cu rezolvarea, sau încarcă pe Moodle documentul 

electronic 

Este de preferat ca să nu fie același subiect pentru toți studenții, ceea ce înseamnă că fiecare student 
ar trebui să aibă un subiect unic, sau măcar să existe un grup restrâns de studenți cu același subiect. 

Variante de mai jos sunt prezentate în ordine crescătoare în funcție de complexitatea configurării. 

5.2. Toți studenții au aceleași subiecte – cu Assignment 
Cea mai simplă variantă este folosind Assignment: 

Turn editing on -> Add an activity or resource -> Assignment 

Fiecare student are un anumit interval de timp la dispoziție ca să încarce fișiere cu rezolvarea 
subiectelor (e.g., problemele, teme). 

Cadrul didactic poate vedea exact data și timpul la care a fost încărcat fiecare fișier în parte. 

Este mai potrivit pentru situația în care studenții au aceeași temă sau același proiect de rezolvat. 
Pentru o mai mare flexibilitate vedeți varianta următoare cu Quiz -> Essay. 

5.3. Studenții au de rezolvat subiecte diferite - cu Quiz -> Essay 
Turn editing on -> Add an activity or resource -> Quiz, cu întrebări de tipul Essay 

La varianta Essay studentul poate încărca fișiere cu rezolvări. Și profesorul poate încărca fișiere cu 
probleme. Adică ar putea fi un număr de probleme încărcate în fișiere (de către profesor) care să fie 
distribuite aleatoriu studenților care dau examen, iar studenții să încarce rezolvările. În acest caz 
corectarea va fi manuală (ca în cazul clasic). 

În același test pot fi incluse ambele tipuri de probleme: cu corectare automată și cu corectare manuală. 

Avantajul față de Assignment este acela că fiecare student va avea propriul lui subiect. La Assignment 
textul subiectului este văzut de către toți studenții din grup. 

În exemplul următor, fiecare student are un subiect aleatoriu dintr-o listă de subiecte. 

Pentru fiecare subiect (fișier) trebuie creată câte o întrebare (Question) de tipul eseu (Essay): 

1. La Question text se va adăuga un link spre fișierul cu subiecte care va fi salvat pe Moodle: se 
scrie numele linkului -> se selectează numele respectiv -> se apasă pe butonul Link  -> Browse 
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repositories -> Upload a file -> de pe calculator se selectează fișierul cu subiectele și se face 
drag-and-drop unde este specificat No file chosen -> Upload this file 

2.  La Response Options  ->  
a. Response format -> HTML editor with file picker 
b. Allow attachments  ->  1 (sau mai multe după caz) 
c. Require attachments  ->  1 (sau mai multe după caz) 

3. Save Changes 

După ce s-au creat întrebările, la secțiunea Edit Quiz a activității Quiz este disponibil în partea dreaptă 
butonul Add -> A random question -> se selectează categoria în care au fost adăugate întrebările (sau 
categoria default) -> Add random question. 

5.4. Studenții au de rezolvat subiecte unice - cu Assignment 
În exemplul următor, fiecare student are subiect unic, dar configurarea testului durează mai mult. 

Se pot adăuga subiectele ca și cum ar fi orice alt fișier care reprezintă cursuri, laboratoare, etc., și apoi 
se restricționează accesul la fiecare fișier ca să poată fi accesat doar de un anumit student. 

Pe pagina disciplinei creați un topic nou (o secțiune nouă) sau utilizați unul existent, ascundeți topicul 
respectiv (Edit -> Hide topic) și adăugați cu drag-and-drop toate fișierele cu subiecte. 

Pe fiecare fișier selectați din dreapta Edit -> Edit Settings  -> Restrict access -> Access restrictions -> 
Add restriction... -> User profile  -> Choose... -> Email address  -> în căsuța din dreapta introduceți 
adresa de email a studentului  -> Save and return to course. 

(Lista cu adresele de email ale studenților se poate obține de la Participants -> se bifează să se 
selecteze toți studenții -> din partea de jos Choose... -> Microsoft Excel (.xlsx).) 

După ce s-a restricționat accesul tuturor studenților, atunci când se dorește ca studenții să vadă 
subiectul asignat, se poate afișa topicul respectiv (Edit -> Show topic). 

Pentru încărcarea rezolvărilor se poate folosi o activitate de tipul Assignment. 

5.5. Studenții au de rezolvat subiecte unice - cu DataForm 

Se poate folosi activitatea Dataform pentru ca studentul să descarce subiectul care i-a fost asignat. 
Pentru încărcarea rezolvărilor se poate folosi aceeași activitate Dataform folosită la descărcarea 
subiectului, sau o activitate de tipul Assignment; aceasta din urmă are avantajul unei mai bune 
organizări a datelor și oferă posibilitatea unui feedback (un efect similar se poate obține și cu 
Dataform, dar necesită mai multă configurare). 

La crearea activității 

1. La secțiunea Timing a activității se pot seta limitările de timp. 
2. La secțiunea Entries -> Separate participants -> Yes 
3. Se apasă: Save and display 
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Din meniul din stânga Dataform activity administration -> Manage -> Fields trebuie adăugat un câmp 
(Field) care să reprezinte fișierul cu subiectele, dar poate reprezenta și fișierul cu rezolvarea 
subiectelor: 

1. Add a field -> Choose... -> File -> Name: Fișier (sau orice alt nume) 
2. Save and continue 

Din meniul din stânga Dataform activity administration -> Manage -> Views trebuie adăugat un view 
pentru student de unde poate să descarce fișierul și eventual să încarce rezolvările, și un view pentru 
profesor de unde să asocieze unui anumit student un anumit fișier: 

1. Add a view -> Choose... -> Aligned: 
a. View general settings -> Name: FisiereStudent (sau orice alt nume) 
b. View Template -> dacă se dorește ca studentul să poată încărca rezolvările, trebuie 

să rămână în câmpul respectiv doar ##addnewentry## și ##entries##; dacă se dorește 
ca studentul doar să descarce subiectul, trebuie să rămână în câmpul respectiv doar: 
##entries## 

c. Entry Template -> trebuie scoase de acolo [[EAC:edit]] și [[EAC:delete]] pentru ca 
studenții să nu poată să șteargă sau să editeze fișiere 

d. Save changes 
2. Add a view -> Choose... -> Aligned: 

a. View general settings -> Name: FisiereManager (sau orice alt nume) 
b. View general settings -> Visibility: Disabled 
c. Entry Template -> trebuie înlocuit [[EAU:name]] cu [[EAU:edit]]; restul rămân la fel 
d. Save changes 

3. Se bifează căsuța Default pentru view-ul FisiereStudent 

Pentru a asocia fiecărui student câte unul sau mai multe fișiere trebuie: 

1. apăsat pe lupa  din dreptul view-ului FisiereManager 
2. Add a new entry -> din listă se selectează studentul, iar în dreapta de face drag-and-drop la 

fișierul (fișierele) cu subiecte. 
3. Save 

Studentul va putea doar să adauge fișiere și să vadă fișierele care i-au fost asociate. 
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6. Trecerea la un nou an universitar 

6.1. Informații pentru studenți 
La trecerea în noul an universitar studenții nu vor mai avea acces la disciplinele la care au fost înrolați 
în anul universitar precedent. Drept urmare, nu vor mai putea accesa materialele de pe platforma 
educațională, rezultatele la teste sau notele încărcate la secțiunea Grades (dacă este cazul) de la 
disciplinele respective. 

6.2. Informații pentru cadrele didactice 
Înainte de noul an universitar vor fi scoși de la fiecare disciplină toți utilizatorii cu rolul de student. 
Astfel, se vor pierde răspunsurile date de către studenți și rezultatele obținute la Assignments, și vor 
dispărea notele de la secțiunea Grades. 

Vor rămâne și nu se vor șterge materialele încărcate de cadrele didactice la fiecare disciplină, mesajele 
postate, întrebările din Question Bank și testele realizate. 

Se recomandă salvarea rapoartelor cu privire la Quiz-uri, Assignments și Grades, precum și banca de 
întrebări (Question Bank): 

- Quiz: De pe pagina aferentă quiz-ului, din secțiunea Quiz administration din meniul din partea 
dreaptă, se navighează la Results -> Grades unde există opțiunea Download table data as ... 
Download. 

- Assignments: De pe pagina aferentă assignment-ului, din secțiunea Assignment administration 
din meniul din partea dreaptă, se apasă link-ul Download all submissions. În acest moment se va 
crea o arhivă cu toate temele încărcare la assignment-ul respectiv și va fi descărcată de către 
browser. Pentru a descărca teme individuale se accesează linkul View all submissions. 

- Grades: De pe pagina aferentă disciplinei, din secțiunea Course administration din meniul din 
partea dreaptă, se apasă link-ul Gradebook setup, apoi butonul Export, după care se descarcă 
notele în formatul dorit. 

- Question bank: De pe pagina aferentă disciplinei, din secțiunea Course administration din meniul 
din partea dreaptă, se apasă link-ul Question bank, apoi butonul Export. De pe pagina respectivă 
se selectează formatul de fișier Moodle XML Format, la Export category se selectează prima 
opțiune selectabilă (i.e., Top for ...) și se apasă butonul Export questions file. 

Mai există și varianta prin care se creează un backup (copie de siguranță) al întregii discipline. Atenție! 
Dacă sunt mai multe Assignment-uri se recomandă ca să faceți backup la fiecare în parte din cauza 
volumului mare de date, iar la backup-ul întregului curs să nu selectați Assignment-urile. Din secțiunea 
Course administration din meniul din partea dreaptă, se apasă link-ul Backup, după care se parcurg 
pașii de pe pagina respectivă. După terminarea backup-ului se poate descărca arhiva pe calculatorul 
propriu. 

Fiecare cadru didactic are posibilitatea să adauge colaboratorii la discipline. 

Studenții vor fi puși în noile grupuri (en., cohort) în momentul primirii datelor de la secretariate (aceste 
date trebuie să includă grupa în care este fiecare student). 
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